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Archivers Overview
The Archivers program is a full service archiving and unarchiving user interface.    The Archivers window 
allows you to compress and uncompress files, using three of the major compression programs, and it 
even allows you to view the contents of a compressed file without uncompressing it.    Archivers also 
includes Microsoft's Compress and Expand programs. 

In addition to its compression and uncompression functions, Archivers also offers a complete file 
management system; allowing you to create directories, delete directories, copy and move files, search 
for files, view and execute files, and rearrange your Windows items and groups - all directly from the 
Archivers window.

The compression program that you are likely to use most often is "PKZIP"    If you don't already have this 
program, you will need to get it in order for this archiving program to work.    You can find the PKZIP 
shareware program on any online service (such as America Online or CompuServe) or on many BBSs.    
It is a Shareware program which has a $47.00 registration fee.    PKZIP is actually a group of EXEs that 
perform different tasks.    For the Archivers program, you will need PKUNZIP.EXE, ZIP2EXE.EXE, 
PKZIPFIX.EXE and PKZIP.EXE.    The PKZIP program is generally considered the industry standard for 
compression.    Much of what you download from online services and BBSs will be in the *.ZIP format.    
PKZIP works by taking a group of files and compressing them into one file.    When you download a ZIP 
file of a program, it will contain all files necessary for running the program.    You can also use PKZIP for 
storing groups of files that you don't use very often and want to store on a disk.    PKZIP compresses the 
files so that you can store more on a disk, and then you can quickly unzip them again if you need to use 
them.    For complete information about the PKZIP options provided in the Archivers window, go to PKZIP.

The two other compression programs that you can access using the Archivers window are LHA (files have
the .LZH extension), and ARJ.    These are two other extensions that you may run into out in cyberspace.   
LHA is a free shareware compression program that you should also be able to find online.    The 
compressed EXE file is LHA213.EXE (EXE name depends on version), but the actual EXE that you need 
for the Archivers program is LHA.EXE.    LHA creates compressed files with the LZH extension.

ARJ is another popular compression program.    It is a shareware program which can be registered for 
$40.00.    The compressed EXE is ARJ241.EXE and should also be available on most online services.    
The EXE that you need for the Archivers program is ARJ.EXE.    It creates compressed files with the ARJ 
extension.

In order for the Archivers program to work, all of the EXE files for these three compression programs must
be loaded into your computer and located in a directory within your path (e.g. the DOS directory).    Your 
path statement is located in your AUTOEXEC.BAT file.    (A typical path statement would be:    PATH = C:\
DOS; C:\WINDOWS; C:\UTILS    etc.)

The Microsoft compression programs Compress.exe and Expand.exe are included with the Archivers 
program and have already been loaded into your Windows directory.    These are accessed using the 
"Compress" menu on the Archivers screen.

Sub-Topics:
Legal Stuff



Legal Stuff
Archivers is a Shareware program.    We encourage you to register this program if you are using it.    You 
can access the Registration form through the Help menu of the Archivers window.    Registration is $14.95
plus $5.00 shipping and handling.    Fill in the blanks in the registration form and then print it out and send 
it in to KnowWare with your check or money order (US Currency only).    As you may know, the Shareware
concept is based completely on the honor system.    Only in cyberspace do people still trust each other 
enough to distribute their merchandise freely and rely on their neighbors to pay for what they use.    We at 
KnowWare are firm believers in the shareware concept.    We ask only that if you use our program you 
pay for it.    Feel free to try it out for 30 days.    If you like it and are using it, we ask that you register it at 
that time.    When we receive your registration we will send you an updated, registered version of 
Archivers.

You can reach KnowWare though e-mail.    We welcome any comments or questions you may have.    

Program written by Gary Pease:      techneek@peak.org
Documentation by Cindy Dyrness:    Cdyrness@aol.com or 75573,1717 (C-Serve)

This program is provided "as is" without representation or warranty of any kind, either expressed or 
implied, including without limitation, any representations or endorsements regarding the use of, the results
of, or performance of the program and information, its appropriateness, accuracy, or reliability.    The entire
risk as to the use of this program and information is assumed by the user.    In no event will KnowWare or 
Gary Pease or Cindy Dyrness be liable for any damages, direct, indirect, incidental or consequential, 
resulting from any defect in the program or information.



Archivers Menus and Button Functions
Click on the different areas of the Archivers window to learn about how it works.



Exit
This closes the Archiver program and returns you to Windows.



Help Menu
Gives you access to this help file and provides the DOS help files for the PKZIP, ARJ and LHA programs.  
Also gives you access to the Archivers Registration form.    We encourage you to register this program if 
you are using it.    Registration is $14.95 plus $5.00 shipping and handling.    Fill in the blanks in the 
registration form and then print it out and send it in to KnowWare with your check or money order.



Dir Size
This menu option gives you the directory size of the Source directory.    "Dir Size" gives you just the 
number of files and size of the selected directory and "Dir + sub-dirs" gives the size and number of files of
all subdirectories as well.



Zip View Menu
Gives three options for viewing the files within your ZIP file.    For details see Zip View.



Compress Menu
This menu gives you access to the Microsoft Expand and Compress programs.    For details, go to 
"Compress" Compress/Expand Program.



Zip Menu
This menu gives you ten different options for compressing files and directories using the PKZIP program.  
For details see ZIPPING.



LZH Menu
This menu gives you seven options for compressing files using the LHA file compression program.    For 
complete instructions see LZH Menu - File Compression.



ARJ Menu
This menu gives you seven options for compressing files using the ARJ file compression program.    For 
complete instructions see ARJ Menu - File Compression.



Editors Menu
Gives you three options for text editors to use for viewing text files.    For more information, see Archivers' 
Editors.



Task List
This menu item gives you access to the Archivers Task List window which lets you know what programs 
your computer is running.    If you get too many programs running at once it will slow down your computer. 
The Task List shows you which programs are running.    If you double click on one of the programs in the 
list it will come up on your screen and you can then close it if you want to.    The Task List also gives you 
information about the system resources that are being used by the applications that you are using, so 
when you close an application you can see what impact that has on your system resources by pushing 
the "Refresh" button to update the resource information.



Source File List and Directory List Boxes
Used for choosing the file or directory that you want to compress or uncompress.    The "*.zip" check box 
above the source file list box allows you to unzip all zip files in the source directory at once.



Target Directory List Box
Used for choosing the directory that will be the destination for your compressed or uncompressed files.



Target File List Box
The File List box shows whatever files are within the presently selected directory.    After you uncompress 
a compressed file, its contents appear in the Target File List Box.    You can then double-click with your 
mouse on a text file to view it, double-click on an EXE file to execute it, or double-click on a BMP or GIF 
file to view it.    See Archivers' Editors, Executing EXE Files, or Viewing BMP and GIF Graphic Files for 
more information.



Extension Box
Allows you to choose the extension of the file you want to uncompress.    Makes it easier to find files in 
large directories.



*.ZIP Check Box
If you click on this check box, ALL ZIP files in the selected Source directory will be uncompressed 
together into the Target directory.



Path Statement
This is the DOS path for the compression or uncompression operation that you are performing.    This 
path statement is actually a text box which it is possible to edit. 



Un zip, Un lzh, Un arj Buttons
These buttons uncompress compressed files.    When you click on a file in the Source file list box, the 
appropriate set of buttons is activated (as with the ZIP file shown here).



Un zip - t, Un lzh -t, Un arj -t Buttons
These buttons run test programs for ZIP, LZH or ARJ files.    See Unzip -t, Un lzh -t, or Un arj -t for 
complete instructions.



Un Span
For ZIP files, this button takes a ZIP file off multiple disks and makes it into a single ZIP file on your hard 
drive.    For more details, see Un Span.



Un lzh -x and Un arj -x Buttons
This is an option for LZH and ARJ which will extract directories and subdirectories of a file if a multi-level 
directory has been compressed.    For complete information, see Un-Lzh x or Un Arj x.



Xtract Exe Button
This button is for uncompressing self-extracting EXE files.    These are files with the EXE extension which 
have been compressed by one of the compression programs.    When you highlight an EXE file in the 
Source file list box, you will see the Xtract EXE button become highlighted.    The Archiver program also 
checks the file before it extracts it to make sure that it is indeed a self-extracting EXE and not a regular 
executable file.    For complete information, see Self-Extracting EXEs.



Reset Button
This button resets the File Extension box back to *.* and it resets both file list boxes back to the root 
directory.



DOS Button
This button takes you to a DOS window (without leaving Windows) so that you can try out any DOS 
programs you might need to.    When you have finished your DOS session, type EXIT to close the DOS 
window and return to Archivers.



Mkdir Button (S) & (T)
This is the Make Directory button.    It will create a new directory inside whichever directory is chosen in 
the directory list box.    Choose Mkdir (S) to make a directory in the Source list box and (T) to make a 
directory in the Target list box.



RD Button (S) & (T)
This is the Remove Directory button.    It will remove the highlighted directory in the    directory list box, but
only if it is empty.    Use RD (S) to remove a directory in the Source directory list box and (T) to remove a 
directory in the Target directory list box.



Copy (S) & (T)
These buttons bring up the Archivers Copy Window which allows you to copy or move files to anywhere 
you want them to be.    The Copy (S) button automatically loads your Source file into the Copy Window 
and the Copy (T) button automatically loads your Target file.    For complete instructions on the Copy 
Window, see Copy Window Overview.



Format Button
This button brings up a window that allows you to format a floppy disk.    For complete instructions on the 
Format window, see Format Window Options.



Search Button
This button brings up a Search window which allows you to search for any file or group of files on your 
system.    It also gives you the option of removing files or copying files once you have found them.    For 
complete instructions, see Search Window Overview.



Delete (S) & (T)
This button allows you to delete any file.    Highlight the file that you want to delete in the file list box and 
then click on the Delete button.    Use the Delete (S) to delete a file from the Source file list box or Delete 
(T) to delete a file from the Target file list box.    After you click on the Delete button, a box will come up, 
listing the file.    To delete it, simply click on OK.    The program will then give you another chance and ask 
you if you are sure you want to delete this file.    Click on Yes or push Enter and the file will be deleted.    
You will see that it immediately disappears from the file list box.    Note that you can also delete a group of
files by using wild card characters in the delete box (e.g. *.TXT).



Windows Group Manager
Clicking on Windows Group Manager brings up the Windows Group Manager window which allows you to
add, delete or rename items and groups in your Windows workspace and also enables you to execute 
any of you Windows executable files.    The Windows Group Manager lists all of your Windows groups 
and items and also has a file list box that gives you access to all files on your computer.    This allows you 
to rearrange your Windows environment in the way that best suits you and to get rid of any groups and 
items that you no longer use.    Go to    Windows Group Manager Functions for complete instructions on 
the Windows Group Manager.



Windows Group Manager Functions

Click on the different areas of the WinGroup Manager window to learn about their functions.    See below 
for further information about the menu items.

Sub-Topics:
Groups
Items
Item Options



Exit
This closes the WinGroup Manager window and returns you to Archivers.    Exit does not reset the Group, 
Item or Directory list boxes, so that if you return to the WinGroup Manager everything will still be where 
you left it.



Clear
This clears and resets all of the Group, Item, Directory and File list boxes.



Help Menu
This accesses the Archivers Help file.



Groups Menu
This menu gives you three options.    You can create a Windows group, delete a group or view a group.    
For complete instructions go to Groups.



Groups
The Groups Menu allows you to create, delete or view a Windows program group.    

To create a group, type in the name that you want it to have in the "Group Name" text box.    Then choose 
Create Group from the Groups menu.    You will see your new    group appear in the list of groups.    

To delete a group, choose it in the "Group Name" box and then choose Delete Group from the Groups 
menu.

Choosing "Show Program Group" from the Groups menu will show you the actual group window with its 
icons.    Minimize the Windows Program Manager window to return to the Windows Group Manager.



Items Menu
The Items menu gives you the options of adding an item, deleting an item, deleting an item and its DOS 
file, renaming an item or moving an item.    For complete information on the Items menu go to Items.



Items
The Items menu allows you to add, delete, rename or move any item within a Windows program group.    

To add an item to an existing program group, choose the group that you want to add it to in the "Group 
Name" box and then go to the directory and file list boxes on the right-hand side of the window.    Choose 
the item you want to add (usually an EXE file; but also HLP, WRI, or TXT files can be Windows items) 
from the file list box and then choose "Add Item" from the Items menu.    It will then appear in the list of 
items for that group.    The item will be given a name automatically, but if you want to give it a name you 
can simply type it into the Item Name box.

To delete an item, choose it in the "Item Name" box and then choose "Delete Item" from the Items menu.   
This deletes the item's icon from the Group window, but it does not delete the actual file from your 
computer.    If you want to completely delete a file from your computer, choose "Delete Item and File" from
the Items menu.    This deletes both the Windows icon and the file itself.

To rename an item, choose the item in the "Item Name" box and then delete it and type in the name that 
you would like it to have.    Then choose "Rename Item" from the Items menu and you will see the item's 
new name in the Item list.

To move an item from one program group to another, choose the item that you want to move in the Item 
Name box and then choose "Move Item" from the Items menu.    You will see a Target Group list box 
appear at the right of the window, as shown in the view below.    Choose the group that you want to move 
the item to and then click on the "Move Item >" button.    You will see the item being moved from one 
group to the other in Windows.



Item Options Menu
The Item Options menu allows you to add a group of files to a program group all at once.    You have the 
option of adding *.exe files, *.hlp files, *.txt files, *.wri files, or all of them at once.    For more information 
go to Item Options.



Item Options
The Item Options menu gives you to option of adding a group of program files to a Windows program 
group all at once.    This may be useful if you want to add a program along with its help file and text files.    
You have five options for items to add.    "Add Selected Directory *.exe" will add all EXE files from the 
selected directory to the program group that you have selected.    "Add Selected Directory *.hlp" will add 
all of the help files from the selected directory.    "Add Selected Directory *.txt" will add all Notepad text 
files from the selected directory and "Add Selected Directory *.wri" will add all Windows Write text files.    
"Add All of the Above" will add all of those types of files to your selected program group.    

To use these options, choose a group or create a group in the Group Name box and then choose the 
directory that you want to add the items from in the file list box.    From the Item Options menu, choose 
which sort of files you want to add to this program group and you will then see those items and the 
appropriate icons being added.



Get File Version Info
To use this function, first choose an item in the Item box or a file in the file list box and then click on Get 
File Version Info.    If the item has version information, you will see a window pop up giving you the version
of the file and other information.    If the file has no version associated with it, a message box will tell you 
so.



File and Directory List Box
This list box shows all of the files on your system.    Use this list box to choose the file that you want to 
add as a new item to one of your program groups.



Group Name Box
This list box lists all of the Windows Program Groups that exist on your system.



Item Name Box
This list box lists all of the items that exist within whichever Group you have selected.    (In Windows they 
appear as icons.)



Path Box
This displays the path of the item in the Item Name box or the path of whichever file has been chosen in 
the file and directory list box.



Execute Item Button
Clicking on this button will execute the file which appears in the Path box - if it is an executable file.    You 
can either choose a Windows item from the Item Name box or a file from the system file list box at the 
right side of the window.



Icon Box
The icon of the item that is chosen in the Item Name box appears here.



Shortcut Keys
If you'd like to save yourself a couple of mouse clicks, you can use these shortcut keys instead.    They 
perform all of the functions listed in the menus.



Shortcut Key List
Opening this drop-down box will show you all of the shortcut keys that have been assigned to the 
Archivers menu items.    Use this list for a quick reference to save yourself some mouse moves.



Delete Target Dir Files Button
Deletes all files in the highlighted directory of the Target directory list box.    Use with care!



PKZIP
Zip View
UNZIPPING
ZIPPING



Zip View
Looking across the menu bar at the top of the Archivers window, one of the menus that you will see first is
the Zip View menu.    This menu gives you three different options for viewing the contents of your ZIP file 
before unzipping it.    All of these options display the file names within your ZIP file, but the different 
options give different technical information about the size and compression of the zipped files.

Sub-Topics:
View Zip Contents -vb
View zip contents -v
View zip contents -vt



View Zip Contents -vb
The first Zip View option is "View Zip Contents -vb."    The -vb switch calls for the "brief" view.    It just gives
the basic information about the zipped files.    It has seven columns of information.    The first column, 
Length, shows the file size before compression.    The second column, Method, gives the type of 
compression routine used.    The third column, Size, shows the compressed size of the file.    The fourth 
column, Ratio, shows the percentage of the reduction in file size.    The fifth column, Date, shows the 
original date of the file, and the sixth column, Time, shows the original time of the file.    The final column 
lists the names of the compressed files. 



View zip contents -v
The second Zip View menu option is "View zip contents -v."    This -v switch is PKZIPs default file view 
option.    It gives you the same seven columns of information as the -vb option does and it adds two more. 
To the left of the Name column you will see the CRC-32 column and the Attr column.    The CRC-32 
column is calculated by the CRC (Cyclical Redundancy Check)-32 routine.    This is the method the 
computer has of checking the integrity of the file during file transfer.    The Attr column lists the stored 
attributes of the file.    The four possible attributes are system, hidden, writable and read-only.    A "*" 
designates an encrypted file.



View zip contents -vt
The final menu item for Zip View is "View zip contents -vt"    The -vt switch gives more technical 
information about the compressed files.    Instead of giving the information in columns, it lists all of the 
information about each file separately and lists the files one after the other down the page.    The -vt 
option gives all of the same information about the file as the -v option with the exception of the Ratio 
information.    In addition, it also gives the File Type (e.g. text, binary), the version of PKZIP used to 
compress the file, and what program is needed to uncompress it (e.g. PKUNZIP v1.0).



UNZIPPING
After you've peeked into your ZIP files, maybe you've found a file that you want to unzip.    The first step in
uncompressing a file is to choose the file you want to uncompress and click on it once.    This will tell the 
Archivers program which uncompression program to use.    You will see the buttons at the bottom of the 
window highlighted to match the file that you have chosen.    If you're working with a directory that 
contains many different kinds of files and you have trouble finding the file you want, you also have the 
option of choosing a files extension in the file extension box in the upper left-hand corner.    For instance, if
you want to find all of the ZIP files, go up and choose the *.zip extension.    Once you have done this, only 
ZIP files will appear when you look into your directories.

The next step is to choose the source and the target for your uncompression process.    The important 
thing to remember about uncompressing or compressing files in the Archivers window, is that you must 
choose both the Source file (or files), on the left side of the window, and the Target directory on the right 
side of the window.    You have to do this even if you are unzipping or zipping something into the same 
directory (i.e. the source and the target directories are the same).    You will notice that when you choose 
the Source and the Target that their paths appear above each file list box.    By looking at these you can 
verify that the Archivers program is correctly reading the file or directory that you have chosen.

So, after you have clicked on the file you want to unzip in the left-hand file list box, go over to the right-
hand list box and choose the destination directory.    And, finally, click on the Unzip button.    You will see 
the DOS screen come up in the top half of your monitor and you will see the unzipping process.    Then 
you will see the unzipped files appear in the right-hand file list box.    The files also appear with their date 
and time of creation in the list box at the bottom of the window and the EXE file (if there is one) is listed at 
the top of that list box.

The Archivers program runs a test on the ZIP file before it executes it.    If it finds a ZIP file that has been 
corrupted, you will get a message that reads "There is a problem extracting this file.    Would you like to 
run Pkzipfix to try to correct this?"    Pkzipfix can often do a pretty good job restoring your ZIP file.    If you 
choose Yes, you will see Pkzipfix run and then you will get a message that says "Pkzipfix has just made a
new file called PKFIXED.ZIP located on your Root Drive.    Now use PKunzip to extract the contents of 
this file in a directory of your choice."    When you click on OK you will see that the Source file list box has 
moved to your root directory and you will see the PKFIXED.ZIP file there.    (If there is no PKFIXED.ZIP 
file on your root, Pkzipfix was not able to recover the file.)    Unzip it like you normally would, and, if 
Pkzipfix was successful, you will see the files uncompressing into your Target directory.

NOTE:    There are times when you have more than one ZIP file that you want to unzip together; perhaps 
part one and two of a program or collection.    You can unzip multiple ZIP files at the same time by using 
the "*.zip" check box above the Source file list box.    Clicking on this box will unzip all ZIP files in the 
Source directory at the same time.    All of the files that they contain will end up together in the Target 
directory.

Sub-Topics:
Archivers' Editors
Executing EXE Files
Viewing BMP and GIF Graphic Files
Archivers Delete Target Dir Files and RD Buttons
Archivers Mkdir Button



Archivers - Copying Files
Un Span
Unzip -t



Archivers' Editors
After extracting the ZIP file, the Archivers window provides you with a few options for viewing the files.    If 
you have a text file that you would like to read (such as a readme file), double-click on the file (in the 
Target box) and most text files will automatically appear on your screen.    If you have an unusual text file 
that double-clicking does not load, go to the Editors menu.    This menu gives you a choice of three 
different text editors to view your text.    Notepad allows you to view most small text files, Windows Write 
allows you to view any Windows Write file (having a .WRI extension) and the DOS Editor will allow you to 
view ASCII text files.    Between the three of these options, you should be able to view just about any text 
file you run across.



Executing EXE Files
The other thing you can do after extracting your files is execute any executable file (.EXE extension).    To 
do this, all you have to do is double-click on the EXE file in the Target file list box .    This will execute 
either a DOS or a Windows program.    If you double-click on a "setup.exe" file, Archivers will take you 
directly to the Windows Program Manager "File Run" command window so that you can run setup in the 
normal fashion.    Executing a program from within Archivers may not always have satisfactory results and
you may need to get out to DOS or Windows to really try it out, but most programs will execute normally.   
This will allow you to try the program and see if you'd like to keep it.    You can also view text files such as 
read.me, readme.txt and read.1st by double-clicking on them in the Target file box.

NOTE:    You may occasionally run across self extracting EXEs, which are files with an EXE extension that
have compressed files within them.    For more information about this type of file, go to Self-Extracting 
EXEs.



Viewing BMP and GIF Graphic Files
Archivers has its own graphics viewer which will allow you to view bitmaps (BMP files) and GIFs.    In 
order to view bitmap files, all you need to do is    double click on the bitmap file that you would like to look 
at.    You will see the picture come up in the center of your screen.    You can maximize the viewer screen 
by clicking the upward arrow in the upper right-hand corner of the viewer window.    To close the viewer, 
click on the close button in the upper left hand corner of the window.    Use the same method to view GIF 
files.    Choose the GIF file that you want to see and then double click on it.    You will notice that the GIF 
viewer has an "Options" menu.    This gives you two options for how the GIF appears on your screen:    
"Stretch" and "Keep Aspect".    If the Stretch option is chosen, the GIF will be stretched to fit your screen.   
If the Keep Aspect option is chosen, the GIF file will keep its proper width to height ratio on your screen.



Archivers Delete Target Dir Files and RD Buttons
If you have unzipped your program into a test directory and you want to clear the directory so that you can
unzip another file, you can use the Delete Target Dir Files button at the top of the file list box.    Clicking on
the Delete Target Dir Files button will delete ALL FILES in that directory (use it with care).    If you have 
created a test directory that you want to get rid of, you can use the RD (T) (Remove Target Directory) 
button.    Clicking on the RD (T) or (S) button will delete the directory that you have highlighted, but all files
must first be deleted out of the directory.



Archivers Mkdir Button
To aid you in the unzipping process, you will also notice the Mkdir (S) & (T) (Make Directory) buttons at 
the bottom of the Target file list box.    These allow you to create a subdirectory either in the Source (S) or 
Target (T) directory box.



Archivers - Copying Files
If you don't want to delete the files you have extracted, but instead copy them to another directory, you 
can use the "Copy" buttons.    The Copy buttons give you a choice between copying from the source list 
box or the target list box.    If you want to copy your extracted files, choose Copy (T) and then the copy 
window will come up, allowing you to copy the files to wherever you want.    Note:    you can use the *.* 
wildcard to copy all of your extracted files at once.    For Copy Window instructions, see Copy Window 
Overview.



Un Span
The Unzip program also has an Un Span option.    This is used only when you have a large ZIP file that 
has been saved on multiple floppy disks.    In order to unzip such a file, you need to insert the final disk, 
choose source and target, and then click Un Span.    Un Span will take the ZIP file off of the disks, 
combine it into one ZIP file and put it into the target directory.    To unzip that file, you then choose it in the 
Source file list box and unzip it in the normal fashion.



Unzip -t
The other Unzip option, "Unzip -t" does not actually unzip your files, but it tests the integrity of the 
compression.    Zipping files can sometimes cause errors.    This option runs a test on your zip file and 
brings up the results in the box at the bottom of the Archivers window.    Use the scroll bar at the side of 
the report box to read the Unzip-t report and then click on the Un zip button if you want to go ahead and 
unzip the file.



ZIPPING
Besides being able to unzip files, the Archivers window also give you the ability to ZIP files.    This is 
useful anytime you want to save a file or a group of files into a smaller amount of memory space.    You 
may also want to use it when space isn't a problem, but you want to combine multiple files into one for 
electronic transport or transport on a disk.

In order to zip a file or a group of files, you need to choose the source file or directory first and then the 
target directory.    To simply zip everything in the source directory, choose your source directory and then 
go up to the Zip menu and choose "Zip (dir)".    The program will ask you for a name for your zip file.    
Type any name, without an extension.    You will then see the DOS screen come up and you will see the 
files being compressed.    When compression is complete, you will see the ZIP file in your target directory.

Sub-Topics:
Zip (Dir) -m
Zip (Dirs) -rP and -rPm
Zip 2 Exe
PKzipfix
Zip File
Zip File -m
Span Disk (-f and -fl)



Zip (Dir) -m
As you can see, the Zip menu also gives you a few other options for zipping files.    The "Zip (Dir) -m" 
option will actually move the zipped files out of the source directory.    Normally when zipping, PKZIP 
leaves the source files in place and creates a new zip file which contains a copy of the files (compressed).
If you do not need to leave the source files in place, the -m option will create a new zip file and eliminate 
the source files.    Other than that, it works exactly like the normal Zip process.



Zip (Dirs) -rP and -rPm
The "Zip (Dirs) -rP" option allows you to zip a directory and include all subdirectories and files within that 
directory.    When the zip file is unzipped, it will contain all subdirectories and all files within them.    "Zip 
(Dirs) -rPm" (as you might guess) compresses all files and subdirectories within a directory into a ZIP file 
and deletes the original directory (and subdirectories).

NOTE:    The Archivers window has been set up to use the -d switch as a default with the unzip command.
This causes subdirectories to be put back in place when a zip file like the one above is unzipped.    If the -
d switch was not used, the files would all unzip into one directory.



Zip 2 Exe
The "Zip 2 Exe" option takes a ZIP file and changes it into an EXE file (executable).    This is helpful if you 
need to send a compressed file to someone who does not have PKZIP or other programs to uncompress 
the file.    Once the file has been made into an EXE file, it can be executed on any computer running DOS 
and the files will automatically be uncompressed.    Note, however, that changing a ZIP file to an EXE file 
adds at least 13 K to the size of your file.



PKzipfix
This menu item runs the PKzipfix program.    If you have a ZIP file that you think may be corrupted, 
choose it in the Source file list box and then choose this menu item.    The PKzip program will then 
attempt to correct the ZIP file and will place it into a file called "pkfixed.zip" on your root directory.    You 
can then unzip it from there in the normal way.



Zip File
The next option in the Zip menu is "Zip File."    This is the option to choose if you want to zip only one file 
instead of an entire directory..    Choose the file and the target in the regular way and then choose Zip File.
A ZIP file will be created in the target directory.



Zip File -m
The "Zip File -m" works in the same way as the "Zip Directory -m."    Instead of zipping a copy of the file, it
removes the file from the source directory and zips it into the target directory.



Span Disk (-f and -fl)
The final two options in the Zip menu are "Span Disk -f" and "Span Disk -fl."    These allow you to take a 
very large ZIP file (larger than the size of your floppy disk) and save it on multiple disks.    The Span Disk 
option also formats the disk before saving the ZIP file onto it.    The Span Disk -f specifies a regular high 
density formatting process, and the Span Disk -fl option specifies formatting for low density disks.    To use
span disk, choose the ZIP file that you want to put onto disk and then choose your disk drive as your 
Target directory.    Choose Span Disk (for the correct disk density) and the program will then prompt you to
put in the disks as they are needed.    When the process is complete, you will be returned to the Archivers 
window.



LHA Program
The LHA compression program (which creates LZH files) is the compression program which is most 
widely used in Japan.    You will find LZH files all over the world, though.    One of LHA's greatest goals, 
aside from compressing and uncompressing files, is to keep you from having duplicate files on your 
system.    So if you ever uncompress an LZH file in which there are files that you already have, you may 
see the LHA program giving you the message "Skipped ... Newer or same file exists."    If you ever run 
into this problem you can get around it by uncompressing the files onto your A: drive (or any drive other 
than the one that contains the duplicate files).

Sub-Topics:
Uncompressing LZH Files
LZH Menu - File Compression



Uncompressing LZH Files
If you have a file with the LZH extension that you would like to uncompress, the process is exactly the 
same as for a ZIP file.    (I suggest that you read the PKZIP instructions in this help file, if you have not 
done so already.)    Click on the file that you want to uncompress, with the LZH file extension, and you will 
then see the "Un lzh" buttons at the bottom of the window become active.    You must then choose your 
destination directory in the Target box.    If you then click on the "Un Lzh" button you will see the LZH file 
being uncompressed into the destination directory.

The Archivers program also tests the LZH file before uncompressing it.    If the file has been corrupted in 
any way, you will get a message that reads "There is a problem extracting this file.    Would you like to try 
to extract anyway?"    If you choose yes, the LHA program will attempt to recover the file.    If it is 
successful, you will see the file being uncompressed into your Target directory.    If no files appear in the 
Target directory, LHA was unable to recover the file and you will not be able to uncompress it.

Sub-Topics:
Un-Lzh x
Un lzh -t



Un-Lzh x
The other Un Lzh button is "Un Lzh x."    This is the Un Lzh option which will extract directories and 
subdirectories of an LZH file if a multi-level directory has been compressed.    This Un Lzh option will also 
work just fine for uncompressing an LZH file without subdirectories, so there's no harm done if you 
choose it by accident.



Un lzh -t
The third LZH button is "Lzh -t."    This runs a test on the LZH file, similar to the Un Zip -t option, and loads
the report into the list box at the bottom of the Archivers window.    The test is especially geared toward 
testing the integrity of the LZH file, to make sure that it hasn't been tampered with by a malicious hacker.   
The Lzh -t option will not tell you anything unless there is a problem with the file.    Otherwise, it will just list
the files inside of the LZH file.    So, if nothing else, this is a quick way to see what files are in your LZH file
before uncompressing it.



LZH Menu - File Compression
If you want to compress files using the LHA program, use the LZH Menu.    The Menu has a variety of 
compression options.

Sub-Topics:
Lha (dir)
Lha (dirs) -r
Lha (dir) -m
Lha (dirs) -rm
Lha (view) l
Lha (file) and (file) -m



Lha (dir)
The first option, "Lha (dir)" is the general, all purpose command for compressing a group of files into an 
LZH file.    The process is the same as for zipping files.    Choose the directory containing the files that you
want to compress in the Source list box, and then choose the destination where you want you LZH file to 
end up in the Target list box.    Choose "Lha (dir)" from the LZH menu and you will see the DOS screen 
come up and the files being compressed.    When the process is complete, you will see your LZH file in 
the Target directory.



Lha (dirs) -r
The next LZH menu option is the Lha (dirs) -r.    This is the option that allows you to compress a directory 
along with its subdirectories.    The process for compressing the files is the same as for the normal LHA 
command.    When the LZH file is uncompressed it must be uncompressed using the Lha x option in order
for the files and subdirectories to be restored to their original places.



Lha (dir) -m
The third option in the LZH menu is "Lha (dir) -m."    This functions the same as the Zip -m option.    Rather
than taking a copy of the source files and compressing them, it actually moves the source files out of their
directory and compresses them, leaving the source directory empty.



Lha (dirs) -rm
"Lha (dirs) -rm" as you might guess, combines the move function with the option that compresses all 
subdirectories.    This option would take an entire directory structure and compress it, while at the same 
time deleting the files from the source directory structure.    Note, however, that the directory structure 
itself is not deleted.    LHA leaves behind the empty directories.    It differs from the ZIP program in this 
regard.



Lha (view) l
"Lha (view) l" is similar to the options in the "Zip View" menu.    It brings up a list of the files in your LZH 
file.    It gives the original file size, the compressed file size, the compression ratio, the date and time of 
the original file, the file attributes, type of compression and the CRC information (Cyclical Redundancy 
Check - helps check file integrity).



Lha (file) and (file) -m
The "Lha (File)," like the Zip (file) option, allows you to compress a single file.    And the "Lha (File) m" 
option allows you to compress a file while moving it out of its source directory.    The process for these 
options is the same as for compressing directories.    Choose the file in the Source file list box, choose the
Target directory, and then choose the Lha (file) option from the LZH menu.



ARJ Program
Uncompressing ARJ Files
ARJ Menu - File Compression



Uncompressing ARJ Files
The ARJ program works the same as the ZIP and LZH programs do.    When you have a file with an ARJ 
extension that you want to uncompress, click on it in the Source file list box and you will see the "Un arj" 
buttons become active at the bottom of the window.    The Un arj button performs the standard 
uncompression function.    After you have chosen your source file, choose the Target directory in the list 
box on the right and click on the "Un Arj" button and you will see the DOS window come up and the files 
being uncompressed.    You will then see the uncompressed files appear in the target directory.

The Archivers program also tests the ARJ file before uncompressing it.    If the file has been corrupted in 
any way, you will get a message that reads "There may be a problem extracting this file.    Do you wish to 
try to correct this problem by using ARJ Recover method?"    If you choose yes, the ARJ program will 
attempt to recover the file.    If it is successful, you will see the file being uncompressed into your Target 
directory.    If no files appear in the Target directory, ARJ was unable to recover the file and you will not be 
able to uncompress it.

Sub-Topics:
Un Arj x
Un arj -t



Un Arj x
The other Un arj option is Un arj x, which is the same as Un lzh x.    This extracts ARJ files which contain 
subdirectories and ensures that the directories end up back in the proper order.    The ARJ program 
actually creates the proper subdirectories before it extracts the files into them.    The Un arj x option also 
works for uncompressing normal single-directory ARJ files, so it can be used interchangeably with the 
plain Un arj option.



Un arj -t
"Un arj -t" is the same as Un zip -t and Un lzh -t.    It runs a test on the ARJ file to test its integrity and 
displays the results in the list box at the bottom of the screen.    Un arj -t displays a list of all of the files in 
the ARJ file with an OK next to them if they pass the test.



ARJ Menu - File Compression
If you have files you want to compress using the ARJ program, then you can choose an option from the 
ARJ menu.

ARJ is a very complex program with many more switches than we have made available in the Archivers 
window.    You can see a complete list of switches in the Arj Help option of the Archivers Help menu.    Or if
you download the ARJ program from an online service it will have complete documentation with it, and 
you can investigate its many options.    For simple, basic compressing, though, we highly recommend the 
PKZIP program.

Sub-Topics:
Arj (dir) a
Arj (dirs) a -r
Arj (dir) m (and -rm)
Arj (view) l
Arj (file) and (file) -m



Arj (dir) a
"Arj (dir) a" is the standard file compression option for compressing a directory full of files.    Choose the 
directory in the Source directory list box and then pick the destination in the Target list box.    When you 
choose the "Arj (dir) a" menu option, all of the files in the Source directory will be compressed into an ARJ
file in the Target directory.



Arj (dirs) a -r
As with the LHA program, "Arj (dirs) a -r" is the option to use if you want to compress a directory including 
the subdirectories which it contains.    It will keep all of the files in their appropriate subdirectories when 
the file is uncompressed (if the Un Arj x option is used.)



Arj (dir) m (and -rm)
The "Arj (dir) m" is the move and compress option.    It takes the files out of the Source directory and 
compresses them into an ARJ file in the Target directory.    As you might guess, the "Arj (dirs) -rm" is also 
a move option , which also compresses directories with subdirectories.    The ARJ program compresses 
all of the files from all of the subdirectories and then it deletes all of those files from the source directories.
Like the LHA program, however, ARJ does not delete the directories themselves.    It leaves behind the 
empty directory structure.    And then, of course, when the ARJ file is uncompressed, using the Un arj x 
option, the directories are recreated and all of the files are replaced within them.



Arj (view) l
The "Arj (view) l" option is ARJ's list option, to show you the files inside of your ARJ file.    The list 
command shows you all of the file names, their original and compressed sizes, the file compression ratio 
for each file, the date and time the file was last modified, the CRC-32 data and the file's attributes.



Arj (file) and (file) -m
The Arj (file) and Arj (file) -m are the options for compressing single files.    Arj (file) compresses a single 
file into an ARJ file and it leaves the original source file behind.    Arj (file) -m moves the original source file
out of its directory and compresses it into an ARJ file.



Compress/Expand Program
Compress.exe and Expand.exe are used by Microsoft to compress the files in the programs that they sell. 
The two EXEs have been included with Archivers and have been added to your Windows directory.    The 
Compress program compresses each individual file and replaces the final character of the file extension 
with a "bar" _.    For instance, archiver.exe becomes archiver.ex_.    The Compress program is different 
than Zip, Arj or Lzh in that it does not compress a group of files into one file.    You can use the Compress 
program to compress an entire directory of files (by using *.*), but you will end up with the same number 
of files; all compressed with the _ at the end of their file extensions.    The files take up less memory space
after compression.

You can use the Compress and Expand programs exactly like you use the other Archiver programs.    
Choose a source file or directory and then choose your target directory.    When using the Expand 
program, you have to expand one file at a time.    You cannot use wildcards.    When you choose a file and
then Expand from the Compress menu, you will be prompted to replace the bar '_' at the end of the file 
extension with the proper letter.    For the file "archiver.ex_", you would take out the bar and replace it with 
an "e."



Self-Extracting EXEs
Besides compressed files with extensions like ZIP, LZH and ARJ, you will also often find compressed files
with the EXE extension.    These are called "self-extracting" EXEs because you execute them like you 
would a normal executable file and then they automatically extract their compressed files.    Obviously 
there is no way to tell just by looking at an EXE file whether it is a regular EXE or a self-extracting EXE, 
but the Archivers program has a test built in to determine what sort of EXE it is.    If you download a 
program from an online service or BBS and it is in the form of an single EXE file, there's a fairly good 
chance that it is self-extracting.    To uncompress a self-extracting EXE, click on the file in the Source file 
list box.    You will see the Xtract EXE button become active.    Choose the destination directory in the 
Target directory list box.    When you press the Extract EXE button the Archivers program will first test the 
file to find out whether it is a self extracting EXE or a regular executable program file.    If it is a self-
extracting EXE you will see the test report come up on your screen with a list of the compressed files.    
Exit from this report and the program will then ask if you want to continue to extract the files from the 
EXE.    If you click on Yes, you will see the files being uncompressed and then they will appear in your 
Target directory.    (If you click on No you will be returned to the Archivers window.)    If it turns out that the 
EXE file is not a self-extracting EXE, a message box will come up saying "Pkunzip does not recognize 
this .EXE file.    Would you like to test for ARJ type EXE?"    The ARJ and LHA programs also have the 
ability to change a file into a EXE file.    If you think your EXE might be one of these, choose Yes.    The 
program will then test it again.    If it recognizes it as an ARJ file, it will continue with the extraction 
process.    If not, you will get a message that says "ARJ does not recognize this .EXE file.    Try LHA?"    If 
you choose yes, the program will run another test.    If it is recognized as an LHA file, it will be extracted.    
If not, you will get a final message that reads "Sorry unable to extract this exe.    May be a program file or 
file is corrupted."



Copy Window Overview
The Copy File window allows you to copy any file or group of files from one location to another.    To do a 
basic file copy, choose the file you want to copy by    clicking on the drive and directory in the directory list 
box on the left and then clicking on the file in the file list box on the right.    You will notice that the file you 
have chosen appears in the "COPY:" box at the top of the form and the path of the file appears in the 
"PATH" box as you do this.    After you have chosen the file you want to copy, click on the "TO:" button.    
This resets the directory and file list boxes so that you can choose the location that you want to copy the 
file to.    Click on the appropriate drive and directory and you will see the path appear in the "TO:" box.    
Once you have chosen the correct destination, click on OK and the file will be copied.    If you then want to
copy another file, click on the Clear menu item and the COPY: and TO: boxes will be cleared.    If you are 
finished copying, click on the EXIT menu item and the Copy File form will close.    

You will also notice that there are some switches on the right-hand side of the copy window.    These 
change the way the copy command works.    Go to Copy Window Button Functions and Switches and 
click on the switches to get a complete explanation of what they do.    There are also some menu options 
that give you some other copy choices.    They are explained below under Menu Options.



Copy Window Button Functions and Switches
Click on the different areas of the Copy window to learn about its functions.

Copy Form as it appears when selecting a file to copy.

Copy Form as it appears when choosing a destination directory or drive.



TO: Button
This is the button which allows you to choose where you want to copy your file to.    After you push it, the 
directory list box and the file list box reset themselves so that you can choose the destination for your file 
by clicking on the appropriate directory.



OK Button
This is the button that you push when you have chosen both the file to copy and the destination.    The OK
button causes the file to actually be copied.



Clear
Click on the Clear menu item if you make a mistake while you're choosing your file or destination 
directory.    It resets the COPY: and TO: text boxes so that you can start again.    You also choose Clear 
after copying a file to reset the COPY: and TO: boxes so that you can choose your next file to copy.



Exit
This menu option closes the File Copy window and returns you to the Archivers program.



/-Y /V
This is a switch that can be used with the copy command to modify the way it works.    The -Y switch 
causes DOS to prompt you for verification before it overwrites a file of the same name in the target 
location.    That is, if you are copying a file named "mine.doc" into c:\docs and there is already a file in 
the \docs directory that has that name, DOS will ask if you want to overwrite it.    If you do not use the -Y 
switch, DOS will not ask you and will overwrite the file.

The /V switch stands for "verify."    This switch causes DOS to double check that the file has been 
correctly copied.    Using this switch causes the copying process to take considerably longer.    You can 
generally count on the accuracy of the Copy command, even without this switch, but if you are copying an
especially important document, you might want to turn on this switch so that you can be absolutely certain
about the accuracy of the copy process.



/-Y
Choosing this switch will cause DOS to prompt you before it overwrites a file of the same name.



/V
Choosing this switch will cause DOS to verify the accuracy of the copy process.    For more information 
about this switch, see the /-Y/V switch.



Help Menu
This menu gives you access to DOS help files and to the help file that you are presently reading.    For 
more information, see Copy Window Help Menu.



Options Menu
This menu gives you access to some additional copy commands including Diskcopy, Xcopy and Move.    
For complete information, see Copy Window Options Menu.



Dir(s) Size
This menu allows you to find out the size of whatever directory or drive you choose, giving you the 
number of files and the number of bytes.    For more information, see Copy Window Dir(s) size.



Source File List Box
These are the list boxes that you use to choose the file or directory that you want to copy or move.



Target File List Box
These are the list boxes that you use to choose the directory or drive that is the destination of the file or 
directory that you are copying.



Copy Window Menu Options
At the top of the Copy window there are three menus that you can pull down to get help and to get more 
copy options.

Sub-Topics:
Copy Window Help Menu
Copy Window Options Menu
Copy Window Dir(s) size



Copy Window Help Menu
The Help menu gives you access to DOS help files and also to the help file that you are now reading.    
The three DOS help files that you can view are DiskCopy, Xcopy and Move.    If you choose one of these, 
a DOS window will come up on your screen and you will see the help file displayed.    There is a scroll bar 
at the right hand side of the screen which allows you to view the help file and there are commands at the 
bottom of the DOS help file screen that tell you how to view other help files.    After you have finished 
reading, go to the File menu in the upper left hand corner and choose Exit.    The DOS window will close 
and you will be returned to the copy window.

If you choose the Copy Window help option, you will view this help file.    From here, you can also access 
Help for the rest of the Archivers program.



Copy Window Options Menu
The Options menu lists three different copy options:    DiskCopy, Xcopy and Move File.

Sub-Topics:
DiskCopy
Xcopy
Move File



DiskCopy
The Diskcopy command creates an exact duplicate of a disk.    It is used with floppy disks only.    When 
you use diskcopy, the source disk is copied byte for byte on to the target disk, therefore, any information 
on the target disk will be erased.    If the target disk is not formatted, diskcopy will also format the disk as it
copies.    When you choose diskcopy, you will see the copy possibilities appear in the lower right hand 
corner of the Copy window.    Choose which disk drive you are copying from and which you are copying 
to.    DOS accomplishes the copy process by copying the entire contents of the disk onto your computer's 
hard disk and then prompting you for the target disk and copying everything onto it.    Some computers 
may not have the memory available to allow this process.    If you are short on memory space, choose the
/M switch.    This will copy a small part of the disk to the hard drive and then prompt you for the target and 
then prompt you for the source disk again to copy the next small part, and so on.    (Be warned!    This can 
be quite a long process!)



Xcopy
Xcopy is a command that allows you to copy a directory and all subdirectories and files which it contains.  
Xcopy will also work exactly like copy if you use it to copy a single file.    When you choose Xcopy, you will
see the /s/e switch appear on the right-hand side of the Copy window.    If you use Xcopy without any 
switches it will copy all files from any directory you choose, but it will not copy subdirectories.    If you 
choose the /s/e switch, Xcopy will copy all files and subdirectories including empty subdirectories.



Move File
The Move command works very much like the copy command except that it does not leave a copy of the 
file behind.    It simply moves the selected file from one place to another on your system.    When you 
choose Move, you will see the /-y switch appear on the right-hand side of the Copy window.    If you use 
the /-y switch, DOS will prompt you before overwriting a file of the same name.    If you do not use this 
switch, the command will overwrite without prompting you.    Choose the source and the destination in the 
same way as you do for a regular copy.



Copy Window Dir(s) size
This menu option gives you the size of    the source directory.    The Dir Size option gives you the size and 
number of files of the present directory.    The Dir + sub-dirs option gives you the number of files and size 
of the directory and all its subdirectories.    These options will also give you the size of whatever files you 
have chosen to copy.    If you choose one file and it appears in the "Copy:" box, the Dir Size option will 
give you the size of that file.    If you have chosen a group of files to copy, e.g. *.exe, the Dir Size option 
will give you the number of files and size of only the selected files.    



Search Window Overview
The Search Files button brings up the Search Files form.    This form can search your entire hard drive or 
disk drive for a file.    The search can contain "wild card" characters such as * (e.g. "*.zip") and will find 
every file that fits the pattern.    If you want to search your entire C: drive, make sure you click on C:\ in the
directory list box.    When you click on the Search button, you will see that the search window changes 
and a black box comes up showing the files as the program finds them.    It also keeps track of how many 
files it finds and the total byte count at the top of the window.    When you finish your search, you can push
Reset to do another search or Exit to close the Search window.    There are text editors available to view 
text files after you have run your search in the Editors menu.    Highlight a text file (in the search results 
box) and then choose the appropriate text editor from the Editors menu to view the text file.

At the top of the Search window, you will also see the Options menu.    This menu contains the Remove 
Files and the Search Attributed Files options.    Remove Files allows you to search for and then delete a
file or group of files.    After you have run your search, you can click on Remove Files and then on 
"Remove Files System Wide."    You will see all of the files being deleted from your system.    If you know 
for sure what files you want to delete, you can also choose the Remove Files option in the first Search 
screen and do the search and the delete functions at the same time.

The Options menu allows you to do a search for Attributed files only.    Attributed files are hidden files, 
system files, archive files and read-only files.    When you choose "Search Attributed Only" from the 
Options menu, you will see that the Search button changes to read "S/Attrib."    After you have run a 
search for the Attributed files on your system, you can then click on each one and see its attributes listed 
at the top of the Search window (as well as its size and date and time of creation).    When you reset the 
Search window it will default back to the regular search function.

Go to Search Window Button Functions to learn more about the Search window menus and buttons.



Search Window Button Functions



Search Button
This is the button you click on to begin your search.    You must first type in what you are searching for in 
the "Search Format:" text box at the top of the window.    When you push this button, a black box appears 
in the middle of the window, showing you the files as they are found.



Reset Button
After a search has been accomplished, the Search button changes to a Reset button.    Push the Reset 
button to reset the Search window if you want to do another search.



Copy To Button
This button allows you to copy a file from your search results to somewhere else on your system.    To 
activate this button you simply have to click on any file in the search results box.    If you click on the 
"Copy To" button you will then see the Archivers Copy window with the file already loaded into the Copy 
"from" box.    You can then copy a file to wherever you want to on your system.



Exit Button
This button closes the File Search window and takes you back to the Archivers window.



Options
The Options menu allows you to do a search for Attributed files only, to search for and remove files, and 
to reset the Search window.    

Attributed files are hidden files, system files, archive files and read-only files.    When you choose "Search 
Attributed Only" from the Options menu, you will see that the Search button changes to read "S/Attrib."    
After you have run a search for the Attributed files on your system, you can then click on each one and 
see its attributes listed at the top of the Search window (as well as its size and date and time of creation).  
When you reset the Search window it will default back to the regular search function.

The Remove Files option allows you to remove files from your system as you search for them, or you can 
remove them after you have your search results.    See Remove Files for complete instructions.    The 
Remove Files Notes menu item gives you some brief instructions on this option.

The Reset menu item will reset the Search box back to its normal function if you have chosen the Search 
Attributed Only and then changed your mind.



Editors
This menu gives you a choice of three different text editors to view your text.    Notepad allows you to view
most small text files, Windows Write allows you to view any Windows Write file (having a .WRI extension) 
and the DOS Editor will allow you to view ASCII text files.    Between the three of these options, you 
should be able to view just about any text file you run across.



Remove Files
Remove Files allows you to search for and then delete a file or group of files.    After you have run your 
search, you can click on Remove Files and then on "Remove Files System Wide."    You will see all of the 
files (the results of your search) being deleted from your system.    If you know for sure what files you want
to delete, you can also choose the Remove Files option in the first Search screen and do the search and 
the delete functions at the same time.



Format Window Options
Click on the options below to learn about the different possibilities for formatting a disk.



Format (default)
This is the regular DOS format command.    Use it for general-purpose disk formatting.



Unconditional /u
This is the lowest level of disk formatting.    With the regular format command you can actually do an "un-
format" and sometimes restore some of your data, but the unconditional format completely wipes out any 
data you may have had on the disk.    



System Files /s
This format command copies the system files onto the disk as part of the format operation.    The three 
system files (IO.SYS, MSDOS.SYS and COMMAND.COM) make the disk bootable.    This means that 
your computer could boot up and load DOS by using this disk if something was wrong with your hard 
drive.



Bad clusters? /c
This is the format command to use if you believe that your disk has bad clusters.    The /c switch will retest
all of the clusters to see whether they are bad, and if they are Format will mark them as bad so that they 
will not be used.    More information about these format switches can be found in DOS help.



Drives
You must choose a drive for the format command to work.    Choose the drive where the disk you want to 
format is.



Disk Type
You must also choose a disk type, so that the computer knows what sort of disk to format.    Most 
computers now use the 1.44M 3.5" disks.



Exit
Clicking on Exit closes the Format window and returns you to Archivers.



Help
The Help menu gives you access to specific help on the Format window and to the Archivers help file.



Default
Clicking on Default will set the Format options to Format (default), a: drive, 1.44 M 3.5" disks.



OK Button
This is the button that you click on when you are satisfied with your format choices and you are ready to 
go ahead and format your disk.




